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Congratulations on your purchase of Finale 2011 for Macintosh! 
 
IMPORTANT: Read this document before you begin working with Finale 2011 and print a copy 
of it to keep with your Finale information.  
 
This file contains important information about Finale 2011 not included in the User Manual as 
well as information about converting older files into the new version's format. Please note that 
Finale 2011 files cannot be opened in previous versions of Finale. 
 
This document is organized by each version's changes; those of you already familiar with earlier 
versions may wish to read only the new information. The Read Me contains the following 
sections: 
 

Running Finale 2011 
New features in Finale 2011 
Fixes in Finale 2011b 
Fixes in Finale 2011a 
Fixes in Finale 2011 

 
You may also visit our web site, www.finalemusic.com for updated information about Finale and 
information on new releases. 
 

Running Finale 2011 
 
System Requirements 
G4 or higher recommended. OS 10.5 or 10.6. Mac Power PC or Mac Intel. 600MB hard drive 
space required for software and User Manual.  
 
DVD-ROM drive. 800x600 minimum monitor resolution. Minimum 512MB RAM 
(1GB or more recommended for optional use of Garritan and Tapspace (VST/AU) sounds: 
more RAM = more available sounds.) An additional 2GB hard drive space is required for 
all included VST/AU sounds. 
 
Optional:   
MIDI interface. MIDI input and/or playback device. Printer. Scanner. 
Microphone required for use of MicNotator®.  
 
Additional AU instruments will perform best with faster processors and hard drives. 
 
Online User Manual 



For full documentation on how to use Finale 2011, see the User Manual. To access the User 
Manual, choose the Help menu, then User Manual. If you have an Internet connection, Finale 
opens the User Manual using your default browser and accesses the latest online content from 
MakeMusic’s servers. If you do not have an Internet connection, Finale automatically opens the 
local version of the User Manual that was installed on your hard drive along side Finale 2011. 
 
Authorizing Finale 2011 
The first time you launch Finale, you will be prompted to authorize. To authorize a single copy 
of Finale, click Authorize Now! to open the Authorization Wizard (or, from the Help Menu, 
choose Authorize Finale). Then follow the instructions to authorize your copy of Finale via the 
Internet, phone, or mail. If you choose not to authorize, you will be prompted to do so each time 
you launch Finale. If you do not register within thirty days, printing and saving are disabled until 
you choose to authorize. 
 
Note that the User/Authorization Codes are computer specific, and will only work on the given 
computer installation. Make sure that the Authorization Code is typed in using capital letters, and 
also verify that the correct serial number has been entered. Your copy of Finale can be 
authorized on two computers simultaneously, and, with an Internet connection, authorization can 
be moved from one computer to another at will. Simply choose Deauthorize Finale from the 
Help Menu to open up a free slot. Your copy of Finale can now be authorized on a different 
computer. When you Deauthorize, printing and saving are disabled until authorization has been 
restored. 
 
If you make a change to the computer (such as replacing the hard drive or motherboard, or 
installing a new operating system), then you will need to re-authorize the installation. If you have 
already installed and authorized twice, you will need to contact Customer Support online at 
www.finalemusic.com/support with your serial number and the location ID for the specific 
installation in question. If the software is not "reminding" you to authorize when you run the 
program, then the registration/authorization has been successfully completed. 
 
Sharing Finale Documents Online with Finale Reader 
Finale Reader provides a free, reliable, easy way to view and playback Finale documents 
downloaded from the Internet. To open a Finale (MUS) file available at Finale Showcase, or 
another online resource, viewers now need to simply download the file to their local machine and 
then open it in Finale Reader. This means all Finale 2011 files posted on the Internet will be 
available for viewing on all machines. Finale Reader is available for download free of charge at 
www.finalemusic.com/reader.  
 
Folder Reorganization 
To accommodate the autonomy of each of a computer's multiple users, and to prevent 
permissions issues, Finale 2011 installs its components to various locations on your hard drive 
depending on their function and required accessibility. See "Finale Installation Details" in the 
User Manual for more information. 
 
Update Groups and Brackets plug-in 
The Update Groups and Brackets plug-in has been removed in favor of Finale's 2011's enhanced 



staff group and bracket functionality. Groups are now assigned to measure regions, and can 
always be modified on either a full-document or a system-by-system basis. See "Group 
Attributes dialog box" in the User Manual for details. 
 
Dragging while holding down a metatool key on notebook computers 
Some notebook computers are set to limit trackpad mouse movement while typing. As a result, 
you may experience sluggish performance while dragging over items while holding down a 
metatool key. To resolve this, open the Preferences pane and deactivate "Ignore accidental 
trackpad movements."   
 
Contacting Customer Support 
For Finale support, visit www.finalemusic.com/support. 
  
Converting Finale 2010 (and earlier) documents into Finale 2011 documents 
Finale 2011 has a different file format than earlier versions, and converts older files to the new 
format when you open them in Finale 2011. Note the following points: 
 
Opening old documents 
Finale 2011 will open and convert older versions' documents, giving them the default title 
"UNTITLED.MUS." We recommend saving a newly converted document with a different name 
than the original file, keeping the older unconverted file as a backup. If you do want to save the 
file using the same name, choose Save As from the File menu. Finale displays the original file 
name, so you can click OK to rewrite over the old file. Finale Maintenance is run automatically 
to check for any errors while opening old files as long as Clean Up File Data is checked in 
Program Options-Open (checked by default). 
 
Running older versions of Finale 
Finale 2010 (and earlier versions) for Windows or Macintosh cannot open any Finale 2011 file, 
except Standard MIDI Files. To share Finale files, the Finale application must have the same (or 
later) version number. 
To open a Finale 2011 document in an earlier version, save the file in MusicXML format and 
then open the MusicXML file using the MusicXML Import plug-in. Finale for Windows includes 
the MusicXML importer back to version 2004, and then back to 2000 using software available 
separately. Finale for Macintosh supports Music XML import back to version 2006, and back to 
2004 (OS X only) using software available separately.  
 
Finale Preferences File 
The Finale Preferences file contains many program settings, from the configuration of your tool 
palette to the display colors you select. Finale stores this file in your System Folder's Preferences 
folder, although it will look first in the same folder for a Preference file. 
 
Finale 2011 does not share the preferences file with older versions of Finale. Finale 2011 will 
automatically load the new Finale 2011 default settings upon launching Finale for the first time. 
To use Finale's default settings at any time, simply delete the Finale 2011 Preferences file from 
the HD/<user>/Library/Preferences folder. A new preferences file will be generated the next 
time you start Finale. 



 
Keep in mind that just as older versions of Finale cannot read the newer version's music files, 
older versions cannot read the newer version's preferences.  
 

New Features in Finale 2011a 
 
• Updated Scanning Technology. Updated scanning recognition technology provides improved 

scanning results and expanded support for Canon-brand scanners. 
• Additional Expression Menu Commands. Four additional commands now allow convenient 

copying of expressions to adjacent staves.  
• Updated Broadway Copyist Font. The Broadway Copyist Text Extended font now includes 

additional characters including Æ, Ø, Œ, ¡, ¿, and others. 
• Improved Font menus and dialog boxes. Finale's updated Font menu and dialog box make 

selecting and editing fonts easier. 
• Improved Quality for Exported Graphics. Exported bitmap graphics are now cleaner and 

sharper. 

 
New Features in Finale 2011 
 
• Hiding Empty Staves. Finale makes it easy to hide staves that don't contain music, in your 

whole score or selected regions.  
• Auto-Showing Music. If you choose to hide empty staves in your score, and then 

subsequently move measures or add notes to the hidden staves, the appropriate notes and 
staves now automatically appear. 

• Hiding Staves Containing Music. Finale makes it easy to hide staves that contain music. 
Need parts for an instrument that you don't want to appear in the score? Simply hide 
staves in the score.  

• Moving Staves. It’s now incredibly easy to move staves. Want to increase the distance 
between staves? Click and drag. Your music updates automatically as you drag and you 
receive on-screen feedback about the distance between the staves and what staves will be 
impacted.  

• Reordering Staves. Want to reorder staves and/or groups? Now it's easily done instantly in 
one place.  

• Enhanced Groups and Brackets. We've simplified the process of editing group names and 
brackets, and to change groups and brackets for the whole score or just selected regions – 
and groups automatically adjust their measure ranges when measures are added or 
removed. It's also easy to show the full staff and group names for any system (very 
helpful when you're starting a new movement).  

• Music containing Lyrics Looks Better – Automatically. The default music spacing of music 
with lyrics is more intelligent, and multiple verses of lyrics are better aligned. Lyrics and 
music space together more intelligently – the way an engraver would prefer.  

• Word Extensions. In addition to better music spacing on melismatic passages, word 
extensions now automatically draw to the next rest. Should you choose to edit a word 
extension, your edits are permanently "locked down," and you can freely drag word 
extensions to subsequent systems.  



• Intuitive Lyric Entry Interface. Lyric fonts, word extensions, and hyphens now instantly 
update as you enter and look exactly as they will print. Should you want to fine-tune, 
you're free to do so with improved handles, drag-select control, and visual feedback 
including lyric attachment lines. 

• Lyrics window. Whether you are typing directly into the score or click-assigning, Finale's 
new Lyrics window accompanies you throughout your lyric entry process.  

• Type Into Score and Auto Update. Finale 2011 makes it much easier to access multiple fonts 
within lyrics. Now you have access to a text menu when you're typing into score. This 
makes it easy to change fonts and sizes while you're typing, and your lyrics instantly 
appear just as they will print out. Similarly all word extensions always update 
automatically.  

• Automatic Lyric Numbering. Finale can now automatically add verse numbers to your 
lyrics. 

• Additional Music Education Worksheets. Finale 2011 includes more than 350 education 
worksheets and more than 400 music education flash cards found in previous versions of 
Finale, plus these additions:Dozens of Jazz Improvisation Worksheets: Finale files that 
playback with the free, downloadable Finale reader and offer tips to beginning 
improvisers AND include jazz rhythm section accompaniment.  

� New worksheets covering concepts related to form and analysis.  
� Dozens of Classroom Resources – popular public domain literature to be used in the 

classroom. Includes folk songs, traditional songs and all Bach inventions. 
� A few new additions to the existing collection of music-themed puzzles and  games.  
• Finale AlphaNotes Font. Created for use with beginning music students, the 

FinaleAlphaNotes font places note names inside noteheads. In addition to note names, 
sharps, flats, and solfège syllables are also provided. Finale 2011 also automates the 
process of applying these new noteheads to any region of any piece.  

• Finale Percussion Font. Many publishers use icons to represent standard percussion 
instruments in their scores. This font contains the most complete collection of percussion 
characters available. Also included are handbell symbols and many unique characters 
including castanets, sine waves, scribbles, and more. 

• Finale Mallets Font. The Finale Mallets font includes icons to represent any variety of mallet 
usages, including the ability to create cross-mallet symbol. For example, you could use 
two of the zero-width mallet characters to indicate the performer should use a yarn mallet 
in the left hand and a hard mallet in the right hand.  

• Apply Capo Chords. Easily add capo chords and fretboards to your arrangement using this 
new utility. 

• Garritan Sounds. Finale now includes more than 375 Garritan sounds. New additions include 
bass trombone, brass section, children ahs, flute section, electronic drum kit, synth space 
voice, synth warm pad, and steel drums.   

• New Aria Player with a new user interface, clearer controls, an integrated Ambiance reverb, 
and a powerful new ability to save Ensembles, allowing you to quickly load multiple 
sounds even when configuring the player manually.  

• Change Percussion MIDI Maps mid-score. You can now assign a new Percussion MIDI 
Map to any point in a staff when multiple non-pitched percussion instruments are used.  

• Improved Pickup Measures. Finale now automatically fills pickup measures with rests.  
• Quick Reference Guide. The included Quick Reference Guide shows you how to complete 



common tasks quickly and easily in Finale. With a graphic-rich presentation, you 
instantly see how to accomplish your goals without reading lengthy descriptions. 

• For details on specific interface changes added since Finale 2010, see Finale 2011 
Interface Changes in the User Manual. 

 
Fixes in Finale 2011b 

 

Expressions 

Expressions are no longer duplicated and linked to one another in specific files. 

File menu 

Opening a specific file no longer causes a crash. 

Fonts 

All Finale document fonts are now recognized in other MakeMusic products including 
SmartMusic, PrintMusic, Finale NotePad and Finale Reader. 

Font type names now work consistently in non-U.S. operating systems. 

Lyrics 

All lyrics, including those on the first system, now update when their fonts are changed via 
the Lyric Window. 

Installation 

Changes to a user’s “Configuration Files” location no longer cause the updater to rename the 
MacOS folder within the Finale application. 

The updater no longer changes the MacOS folder within the Finale application. 

 
Fixes in Finale 2011a 

 

Expressions 
Changes made to the Expression Assignment dialog box in a part will no longer cause the 
expression to only display in that part. 

Expressions no longer become assigned to every staff when generating parts in files created 
before Finale 2009. 

Horizontal and vertical offsets are now cleared in parts if an expression is using a Score List. 

Duplicate expressions no longer appear if horizontal and vertical offsets have been altered in 
the Expression Assignment dialog box for an expression with a mixed Score List. 

Clearing positioning changes for expressions is no longer dependent on the Score List 
configuration. 

File names in "Missing Graphics" boxes no longer exceed 12 points. 



Display 

Switching from the Staff tool to the Speedy Entry tool no longer leaves hidden staff line 
artifacts. 

Switching layers when lyric attachment lines are showing no longer leaves artifacts. 

Custom Tool Sets now display properly after quitting and relaunching Finale. 

Resizing the Master Tool Palette no longer resets the Tool Set arrangement. 

There are no longer drawing artifacts when scrolling music vertically with the Message Bar 
turned off. 

Resizable font dialog boxes now remember their sizes. 

When no parts are defined, "Generate Parts" now appears in the Document menu instead of 
"No Parts Defined." 

The page number display now advances to current page during music entry. 

The Positioning tab of the Expression Designer dialog box is no longer missing its images. 

The Page Number text box no longer remains in focus when it should not. 

The view percentage no longer affects the drawing of staff lines in the Measure Number 
Positioning dialog box. 

Changes to multimeasure rest settings in Document Options-Multimeasure Rests are now 
applied without needing to switch views.  

Pressing Return in the Key or Clef dialog box no longer causes the dialog to reappear on 
Cancel/OK.  

The Smart Shape Placement dialog box no longer draws incorrectly for slurs with only one 
editable endpoint. 

Document Options 

Changing the Underline Options in Document Options-Lines & Curves now enables the 
Apply button. 

Edit menu 

Choosing "Clear Selected Items" no longer enables "Use Filter." 

Exercise Wizard 

Going to the Exercise Wizard before selecting a default file no longer prevents Finale from 
copying files to the local user's Music Files folder. 

FinaleScript 

The Close and Save button in the Script Editor is now consistent between Mac and Windows. 

The Batch Process folder can now be changed. 

Finale will no longer crash on launch if FileVault is enabled (Found in System Preferences in 
the Security Pane of OS 10.5 and 10.6). 

The keyword "near" now functions consistently. 



FinaleScript's Text Search and Replace feature now behaves like Finale's Text Search and 
Replace feature (only changing the specified type of text). 

Fonts 

æ, ø, ¡, ¿, and other characters have been added to the Broadway Copyist Text Extended font. 

Graphics 

The "Link to File" check box in the Check Graphics dialog box now functions properly. 

Linked graphics are now found after opening pre-Finale 2011 documents.  

Graphics less than 72 dpi are no longer scaled-up when being placed. 

Human Playback 

Custom sharp, flat, and natural Smart Line Trills are now interpreted correctly. 

Swing playback with Garritan instruments and Human Playback now works properly. 

Closing or saving while Human Playback Preferences is open no longer creates duplicate HP 
Preferences. 

Lyrics 

The cursor position for lyrics in scaled staves has been corrected. 

Problems viewing the Font menu in the Category Designer for extracted parts have been 
resolved.  

Undo then deleting lyrics in the lyric window that are not assigned no longer incorrectly 
deletes lyrics in the score. 

The Specify Current Lyric dialog box no longer allows selection of Verse 0. 

Applying Note Spacing in a linked part without lyrics no longer results in missing word 
extensions or hyphens. 

Word extensions across systems can now be extended into measures of rest if there are no 
more notes in the staff. 

Lyrics Window text no longer appears very large while printing. 

The lyric font can now be changed with the standard Font dialog box. 

Measure Numbers 

The View Percentage no longer affects the drawing of staff lines in the Measure Number 
dialog box.  

Multimeasure Rests 

Slash Notation in Layer 4 is no longer ignored when creating Multimeasure rests. 

MusicXML (5.5.0.0) 

Drag-and-drop opening for compressed MusicXML files is now supported.  

Capo chords with simplified spelling no longer cause the entire file export to fail in some 
situations. 



Invalid ending measure numbers in Finale slurs no longer cause the entire file export to fail. 

Text in the Times font is exported more accurately when incorrectly labeled as a symbol font 
within the Finale file. 

Lyric font defaults are exported more accurately when the Finale file has only one type of 
lyric (e.g. verse, chorus, section). 

System breaks are imported more accurately from PhotoScore MusicXML files. 

Top staff only measure numbering is exported more accurately for piano/vocal music with a 
piano introduction. 

Opening a MusicXML file from the finder will no longer fail if the Mac Finder type is 
correctly set to 'XML3.' 

NoteMover tool 

There is no longer an erroneous check mark next to the "Delete" option in the NoteMover 
context menu.  

Opening 

Data Check now runs by default when opening files. 

Opening a file while a dialog is in focus can no longer partially open the file without creating 
a window. 

Finale no longer incorrectly identifies files when the full path of the file cannot be 
represented as Mac Roman text. 

Page Layout 

Moving measures to a page out of view can no longer hang Finale.  

Problems dragging systems in some files have been resolved. 

The Edit System/Page Margins dialog boxes now undo correctly. 

Page layout errors while opening old files have been resolved. 

Parts 

Parts with colons in the part name no longer prompt a save dialog when extracting parts. 

Playback 

There is no longer an extremely loud sound when closing some files. 

Crashing on playback related to Ambience Reverb in some files has been resolved.  

Kontact 4.1 now loads properly on OS 10.6. 

Loading Audio Units during Simple Entry no longer crashes Finale. 

Printing 

The print dialog now defaults to All for Page Range. 

Program Files and Folders 

Files and folders with non-ASCII characters now copy to the appropriate user folder. 



Plug-ins 

Global Staff Attributes: The Global Staff Attributes plug-in now supports the new Finale 
2011 Staff Attributes updates including Force Hide Staff and items in the Items to Display 
section. 

Score System Divider: Now works properly if staves have been respaced. 

Vertical Collision Remover: Now fixes collisions with chords. 

Repeats 

Alternative text added to repeat endings can now be removed. 

New 1st/2nd ending repeats now appear on the top staff only. 

Deleting a repeat no longer changes Repeat metatool assignments. 

Metatools in the Repeat Selection dialog box no longer react to the zoom level. 

Scanning 

Improved scanning with Canon LiDE series scanners. 

Setup Wizard 

Multiple items can now be selected in the second and third columns of the second page of the 
Setup Wizard. 

The page size and description now displays properly when returning to page 1 of the Setup 
Wizard. 

Simple Entry/Speedy Entry 

Page and measure navigation controls now accept numerical input when using 
Simple/Speedy Entry. 

Shape Designer 

Cursor problems in the Shape Designer window have been resolved. 

Spotlight 

The spotlight plug-in no longer crashes when attempting to view the file info. 

Staves 

A "Distance from Previous Staff" value can now be added that places the staff beneath the 
original subsequent staff position (as subsequent staves move down uniformly). 

The "Distance Between Staves" value now appears as soon as a staff handle is clicked. 

A Preview button in the Staff Usage dialog box now allows changes to be viewed 
immediately in the score. 

Dragging the top staff in documents containing only one system per page now adjusts 
systems out of view correctly. 

Note Shape Staff Styles no longer revert to Replace…On Scale Degree. 

Deleting the top staff without repositioning can no longer cause dragging restrictions that 



allow staves to become out of order. 

Dragging the top staff of a system can no longer result in a non-zero "Distance From Top of 
Previous Staff" value. 

Ties 

Ties across barlines now attach correctly when slash notation exists in the following measure. 

All tied notes that have been flipped enharmonically now transpose. 

It is no longer possible for an accidental to appear on the end tie note. 

Time Signatures 

There is now a wait cursor when changing the time signature in large files. 

 
Fixes in Finale 2011 

 

Articulations 

Problems related to note duration selection in the Apply Articulations dialog box have been 
resolved. 

Audio Units 

Waves plug-ins are no longer re-evaluated every time Finale launches. 

Audio Units settings are no longer lost while extracting parts. 

Audio Tracks  

Audio file import errors have been resolved. 

Chord Symbols 

Problems related to missing chord symbols have been resolved. 

Enharmonics 

Enharmonic alterations are now retained when notes are moved to subsequent measures. 

Equivalent enharmonic spellings are now recognized when reducing notes. 

Exercise Wizard 

Selecting certain exercises while a document is open no longer causes poor performance. 

FinaleScript 

Two copies of all documents are no longer printed when processing a folder. 

Fonts 

Data Check-Font Utilities now changes the font of measure numbers. 

Human Playback 

Human Playback no longer causes unexpected CC11 data. 



Errors regarding inserting keyswitches have been resolved. 

Dynamics now play back correctly with Garritan Sound Effects. 

Trill accidentals are now interpreted correctly. 

Rare instruments such as harpsichord and accordion are now supported.  

Lyrics 

Performance problems related to Click Assignment in OS 10.6 have been resolved. 

Handles no longer become displaced when clearing manual positioning of syllables. 

Finale no longer crashes when clearing all word extensions with the Delete key. 

Measures 

The default horizontal position of measure numbers in documents without libraries has been 
restored to 0. 

MIDI Tool 

Closing the Listen dialog box while viewing continuous data in the MIDI editor, or in 
Transcription Mode, no longer causes a crash or unexpected behavior. 

The Esc key now cancels the Listen dialog box. 

Movie Window 

File links to some .mov files are no longer lost when saving and opening a file.  

Page Layout 

Extraneous pages are no longer created after copying notes with Automatic Update Layout 
enabled.  

Playback 

The message bar now updates during spacebar-click playback. 

ScoreMerger 

ScoreMerger now handles pickup measures correctly. 

Selection 

Drag-selecting now always selects all measures in the enclosed region. 

Stack selection can no longer appear when no all staves are selected. 

Simple Entry 

Screen artifacts and redraw errors related to the Simple Entry Cursor have been resolved. 

SmartMusic Accompaniments 

Non-General MIDI percussion sounds are no longer off-by-one when saved as a Solo .SMP 
file, permitting proper percussion playback 

Speedy Entry 

Pressing the Tab key no longer corrupts the page navigation controls. 



Staves 

Deleted staves are now removed from systems in parts with Hide Empty Staves applied. 

Context-clicking a staff or group handle and then clicking outside the context menu no longer 
erroneously selects measures. 

Deleting a staff no longer transfers highlighting to the staff below. 

Staff handles can no longer be deselected while measures in the staff remain selected. 

Distances in the Staff Usage and Respace Staves dialog box are now positive. 

Staves beneath a staff being dragged no longer continue to move after the dragged staff is 
restrained by a page margin. 

The staff order can no longer be changed in the Respace Staves dialog box. 

Applying Music Spacing to a pickup measure in the Staff Tool no longer opens the 'partial 
measure' warning. 

Text 

Measure-attached text blocks can now be reassigned after they have been created. 

Errors related to copying and pasting text inserts into other programs have been resolved.  

Ties 

Changes made to one tie no longer affect all ties on the same note. 


